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P6 Analytics enables you to use Oracle Business Intelligence Answers to create requests that will display P6 

EPPM data based on the criteria that you set for the request.  

In This Chapter 

Using the Administrator's Guide ............................................................................................................. 9 

P6 Reporting Database and P6 Analytics Documentation .............................................................. 10 

Where to Get Support ............................................................................................................................ 10 

 
 

Using the Administrator's Guide 

This guide is a step-by-step guide to installing and configuring both P6 Reporting Database and P6 Analytics. 

For P6 Reporting Database, this guide provides the following information: 

Provides an overview of P6 Reporting Database. Lists and describes the prerequisites for installing and 

using P6 Reporting Database.  

Provides instructions for installing and configuring P6 Reporting Database in an Oracle environment. 

Describes installing and configuring the Oracle Gateway for environments that use P6 EPPM in 

Microsoft SQL Server. Installation of P6 Reporting Database on a Microsoft SQL Server system is not 

supported. 

Provides information about P6 Reporting Database administrative tasks. Also describes the tasks for 

installing and configuring Oracle Business Intelligence Publisher, running the Configuration Utility, and 

provides troubleshooting information. For information about installing Oracle Business Intelligence 

Publisher, refer to the Oracle Business Intelligence Publisher documentation. 

For P6 Analytics, this guide: 

Provides information about P6 Analytics administrative tasks. Also includes information for Star 

security configuration, OBI installation and configuration, Financial Periods installation and 

configuration, and for configuring the Secure Sockets layer. 

There are two types of hyperlinks in this document: 

 Links that will take you to various parts of this document. For these types of links, click on the actual 
page number. For example, in the following you would click on the actual number, 45: 

See ODS Security Configuration (on page 45) 

 Links that appear as actual URLs. For these types of links, click inside the URL. For example: 

http://www.oracle.com/technetwork/documentation/primavera-093289.html 
 

Preface 
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P6 Reporting Database and P6 Analytics Documentation 

You can access the P6 Reporting Database and the P6 Analytics documentation from the physical media or 

download location (the most up to date documentation is available on the Oracle Technology Network 

(OTN)).  

Go to the following website, and then select the link for the appropriate version of Primavera P6 Enterprise 

Project Portfolio Management:  

http://www.oracle.com/technetwork/documentation/primavera-093289.html 

Double-click the applicable PDF file to view the information in Adobe Acrobat Reader. The following table 

describes the available documentation. 

Title Description 

Oracle P6 Reporting 

Database Administrator’s 

Guide 

Explains how to: 

 Install and configure P6 Reporting Database. 

 Generate the ODS database. 

 Install and configure the Oracle Gateway if the P6 EPPM is 

installed on a Microsoft SQL Server. 

 Run the Configuration Utility 

Oracle P6 Reporting 

Database User’s Guide 

 

Provides information about using ODS and Star with the P6 EPPM 

database to extract data that you can use to create reports. 

P6 Analytics Administrator’s 

Guide 

Explains how to: 

 Install and configure the Star database. 

 Install and configure the Oracle Business Intelligence software. 

 Configure Oracle Business Intelligence to work with P6 

Reporting Database. 

 Run the Configuration Utility. 

Oracle P6 Analytics User’s 

Guide 

Provides information about: 

 Using Oracle Business Intelligence to create reports. 

 Oracle Business Intelligence Dashboards and Answers. 

 The Security Guidance icon, , helps you to quickly identify 

security-related content to consider during the P6 Reporting 

Database and P6 Analytics installation and configuration process.  

 
 

Where to Get Support 

If you have a question about using Oracle Primavera products that you or your network administrator 

cannot resolve with information in the documentation or help, go to: 

http://www.oracle.com/us/support/index.html 
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This page provides the latest information on contacting Oracle Global Customer Support and the support 

renewals process. 

Go to http://download.oracle.com/docs/cd/E17266_01/index.htm for the latest updates to the P6 

EPPM 8.0 Documentation library. 
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This section provides a general overview of P6 Reporting Database, including the Extract, Transform, and 

Load (ETL) process, and scheduling updates from the P6 EPPM Database.  

It provides an overview of the P6 Analytics, a separately sold product that provides customers with an 

in-depth and comprehensive method for analyzing and evaluating their project performance, project 

history, and resource assignments and utilization.  

In This Chapter 

About P6 Reporting Database ............................................................................................................... 13 

About Security in P6 Reporting Database and P6 Analytics ........................................................... 15 

About the ETL Data Process .................................................................................................................. 15 

About Scheduling....................................................................................................................................... 15 

About History Fact Trending ................................................................................................................. 16 

About Dimensions .................................................................................................................................... 16 

About Calculated Fields ........................................................................................................................... 16 

About P6 Analytics ................................................................................................................................... 17 

 
 

About P6 Reporting Database 

P6 Reporting Database works with the P6 EPPM database to provide a robust and powerful reporting 

solution. With P6 Reporting Database, you can create day-to-day operational reports based on all aspects 

of your P6 EPPM data, through use of the Operational Data Store (ODS). 

With the addition of P6 Analytics (sold separately), you can perform business intelligence analysis using the 

Star Schema (Star).  

The Extract, Transform, and Load (ETL) process provides data movement between the P6 EPPM database 

and the ODS and Star reporting databases. 
 

About the Operational Data Store (ODS) 

The Operational Data Store portion of P6 Reporting Database is a relational database that supplies 

day-to-day, easy to understand operational views of the P6 EPPM database data.  

By persisting and transforming data, customers can create unique reports based on all aspects of their P6 

EPPM data. The ODS provides the most granular view of the P6 EPPM database data. It applies P6 

Integration API formulas for many types of calculated data that otherwise would not be visible in the P6 

EPPM database by using a direct query (for example, percent complete, variances, earned value, and WBS 

spreads). 

P6 Reporting Database users can view the same OBS, project, cost, and resource data in the ODS as they 

can in P6 EPPM. 
 

Before You Begin 
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About the Extract, Transform, and Load (ETL) Process 

The ETL process provides data movement between the P6 EPPM database and the ODS and Star reporting 

databases. Part of the ETL process is to de-normalize the P6 EPPM database. 

 

P6 EPPM data is extracted, calculations applied in a staging area, and the data is loaded into the ODS and 

Star databases. The ETL process can be scheduled to run at regular intervals, using operating 

system-specific scheduling tools, to  ensure up-to-date data freshness. The ETL process requires an 

intermediate staging database to perform calculations before delivering the data to the ODS and Star 

databases. 

The ETL process: 

 Ensures that data is optimized for analytical reporting. 

 Fulfills the schedule refresh window. 

 Accommodates on-demand refreshes. 

 Implements the P6 EPPM security model at the database level. 

The following figure illustrates the ETL process: 

 

In the preceding figure: 

 The Stage schema is created with a complete copy of the P6 EPPMdata (ONLY during the Full ETL 
process). 

 The Stage schema contains not only an exact copy of the P6 EPPM data, but also de-normalized and 
persisted calculated P6 EPPM fields. 

 During the Full or Incremental ETL process, a combination of PL/SQL statements and Integration API 
calls is used to de-normalize and persist calculated P6 EPPM fields into the Stage database. 

 After the API process completes, PL/SQL is used to distribute physical, calculated, and de-normalized 

data from the Stage database to the ODS and Star schemas. 
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About Security in P6 Reporting Database and P6 Analytics 

This section provides an overview of the security for ODS and Star databases. 
 

About ODS Security 

The ODS security model emulates the P6 EPPM security model. The Resource and Project Access control 

policies are maintained in ODS. See "ODS Security Configuration (on page 49)" in the P6 Reporting 

Database Administrator's Guide or in the P6 Analytics Administrator's Guide, and also "ODS Security" in the P6 

Reporting Database User’s Guide or in the P6 Analytics User's Guide for more information.  
 

Star Security Overview 

The Star maintains security similar to P6 EPPM. The security being maintained consists of Project/Cost 

security, Resource security, and OBS security.  See "Setting Up Star Security (on page 53)" for more 

information. 
 

About the ETL Data Process 

Integration API 

At the scheduled time, the ETL process launches the P6 Reporting Database Integration API, which 

calculates changes to the underlying data in the P6 EPPM database since the last time that the ETL process 

was run. 

When the API calculation has completed, stored procedures are called that perform the transformation 

processing (for example, calendar calculation and hierarchical referencing). 

When transformation processing completes, distribution occurs from the Stage database to the ODS 

database and Star database . 
 

About Scheduling 

Once the ODS and Star databases are fully installed, you will decide when and how often to update the 

databases from the P6 EPPM database. These updates will be performed in an incremental fashion. This 

means that only the data that has changed in the P6 EPPM database since the last time the ETL process was 

run will be transferred.  

The process for updating the ODS and Star databases can be launched in the following ways: 

 Manually when required. 

 Scheduled to occur exactly once sometime in the future. 

 Scheduled to recur during regular intervals. 

The file that launches the ETL process is: 

 incremental.bat on a Windows platform. 

 incremental.sh on a non-Windows platform. For information on supported non-Windows platforms, 
see the Tested Configurations document on the release media or download. 
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The incremental.bat or incremental.sh file resides in the following folder of your P6 Reporting Database 

installation folder: 

<installation folder>\p6rdb 

To ensure that your P6 Reporting Database system has the latest data from the P6 EPPM database, it is 

recommended that you run the incremental data refresh process daily during non-peak hours. 

Note: Allow sufficient time to complete the scheduled run of the ETL process. 

The start of a process should not over-run the completion of another. This can 

cause unexpected results, and is not recommended. 

Any mechanism can be used to launch, or schedule the launch, of the incremental.bat (or incremental.sh) 

file. The Windows AT command, Task Scheduler, or Unix CRON are all viable options.  The user who 

initiates the Incremental process needs read/write access to the P6 Reporting Database installation folder. 
 

About History Fact Trending 

When the incremental.bat (or incremental.sh) file is run, it updates both the ODS and the Star database 

with the latest data from the P6 EPPM database.  

In addition, the Star has the ability to retain Project level data from any previous run of the ETL process, so 

that multiple sets of Project level data can be accumulated within the Star database.  
 

About Dimensions 

Dimensions are a functionality of the Star schema, and describe how a business views and analyzes its data. 

For example, actual project cost results might be analyzed (or grouped and sorted) by the time dimension 

(when they were planned or when they were actually incurred), and by the project dimension. 

The time dimension can also provide comparison (for example, the previous year results versus the current 

year results). 

For a list of the Dimension tables, see "Tables in the Star Database" in the "Star Schema (Star)" section of 

the P6 Analytics User’s Guide. 
 

About Calculated Fields 

Calculated fields apply to both the ODS and Star databases, and are not stored as physical fields in the P6 

EPPM database. Instead, values stored in the P6 EPPM database are loaded by the application, and 

calculations are applied in memory. During the ETL process, these values are calculated by the API and 

stored as physical fields in the ODS and Star.  

For example, the actual hours measure shows how many hours each resource has charged to a given 

project or WBS during specific time periods. During the ETL process, the actual hours are “spread” across 

the specific time periods, and the data is placed in periodic buckets in the ODS and Star databases. 
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About P6 Analytics 

P6 Analytics, sold separately, provides an in-depth and comprehensive method for analyzing and evaluating 

project performance, project history, resource assignments and utilization. It includes all P6 Reporting 

Database functionality, and also includes the Star database. See About the Star Database (on page 17).  

Built upon the Oracle Business Intelligence suite (Dashboards and Answers), it delivers a catalog of 

Dashboards and Answers requests that provide an interactive way of viewing, analyzing, and evaluating P6 

EPPM data. In addition, it provides a Repository (RPD) file that contains the data mappings between the 

physical data and the presentation layer of OBI. 

The dashboards provide detailed insight into your P6 EPPM data through the use of analytical charts, tables, 

and graphics. Dashboards have the ability to navigate to other requests to provide precise root cause 

analysis. In Addition, you can configure individual requests with the P6 EPPM Action Link, enabling you to 

navigate directly to your P6 site for true "Insight to Action" capabilities. Reports created with Oracle BI 

Answers can be saved in the Oracle BI Presentation Catalog, and can be integrated into any Oracle BI home 

page or dashboard. Results can be enhanced through options such as charting, result layout, calculation, and 

drill-down features. 

P6 Analytics provides an RPD file to be used with the Oracle Business Intelligence suite. The RPD file 

contains: 

 A physical representation of the Star schema. 

 A business layer where customized calculations are performed. 

 A presentation layer that groups all of the Star database fields into logical subject areas. 

The RPD delivers an extensive amount of Earned Value, Costs, Units, Percent Completes, and other key 

performance indicators. It enables data to be sliced by items such as time, project, eps, portfolios, activities, 

and resources. 

P6 Analytics delivers a sample dataset, consisting of Star data, from which the Dashboards and Answers 

requests in the catalog were built. This sample data can be used to view the power of dashboard and 

Answers requests delivered in the catalog, which will give the user an idea of how the catalog can be 

integrated with their data. For information on configuring the sample dataset, see the P6 Analytics 

SampleData.pdf document that is included in the P6Analytics\Sample folder on your release media or 

download. 
 

About the Star Database 

The Star database enables an organization to perform advanced business analysis on project and portfolio 

data. It supplies a dimensional schema that organizes P6 EPPM hierarchical relationships.  

 P6 Analytics enables the highest level of query efficiency and flexibility in data analysis. The Star database is 

designed to accumulate project data over time. This provides organizations with baselines for tracking 

trends and for advanced business intelligence.  
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This section describes the prerequisites for installing and using P6 Reporting Database. It includes required 

database instances, supported databases, and disk storage space requirements. 

The P6 EPPM must already be installed, and a P6 EPPM database already created. 

In This Chapter 

P6 EPPM and JRE Requirements ............................................................................................................ 19 

Oracle Gateway Installation Requirements ........................................................................................ 19 

Oracle Password Requirements ............................................................................................................ 20 

Oracle tnsnames.ora File Requirements.............................................................................................. 20 

Required Database Instances, Collation Requirements, Character Sets, and Database Locations

 ....................................................................................................................................................................... 20 

Operating System User Permissions .................................................................................................... 21 

Disk Storage Space Requirements ........................................................................................................ 21 

Bulk File Load Requirements .................................................................................................................. 22 

Creating the Oracle Tablespaces .......................................................................................................... 22 

 
 

P6 EPPM and JRE Requirements 

P6 EPPM must be installed, and a P6 EPPM database must already be created. 

The current versions of the P6 Reporting Database R2.1 and P6 Analytics R1.1 software are compatible 

with Oracle Primavera P6 EPPM schema version 8.0.  

The appropriate version of JRE must be installed on the machine where the ETL process will be run. For 

information on the specific JRE versions and supported operating system configurations, refer to the 

testedcfg.html document on the release media or download. 

If the P6 EPPM database is a Microsoft SQL Server database, the Oracle Gateway application must be used 

to connect the P6 EPPM database to the Stage Database on the Oracle server.  

The Stage, ODS, and Star databases must be in an Oracle instance. Using Microsoft SQL Server for Stage, 

ODS, and Star is no longer supported. For more information, see Oracle Gateway Installation 

Requirements (on page 19).   
 

Oracle Gateway Installation Requirements 

If your P6 EPPM database is a Microsoft SQL Server database, you must install the Oracle Gateway. Go to 

one of the following web sites for information about installing the Oracle Gateway: 

 For Oracle Gateway 10g, go to the following web site: 

http://www.oracle.com/technology/documentation/gateways10g.html 

Prerequisites 
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 For Oracle Gateway 11g, go to the following web site: 

http://download.oracle.com/docs/cd/B28359_01/gateways.111/b31043/toc.htm 

Note: The URLs for the preceding web sites should each be on one line. Format 

restrictions of this document might prevent them from appearing on one line. 

After you install the Oracle Gateway, you must configure it to use the P6 EPPM database. See Configuring 

the Oracle Gateway for a Specific Microsoft SQL Server Database (on page 39). 
 

Oracle Password Requirements 

 For information on Oracle password requirements, see the following web site: 

http://download.oracle.com/docs/cd/B28359_01/server.111/b28337/tdpsg_user_accounts.htm#BEICECG

F 

Note: The preceding URL should all appear on one line. Format restrictions of 

this document might prevent it from doing so. 

 

Oracle tnsnames.ora File Requirements 

Ensure that the tnsnames.ora file contains references to the P6 EPPM database, the Stage database, the 

ODS database, and the Star database, before configuring these databases. 
 

Required Database Instances, Collation Requirements, Character Sets, and Database 

Locations 

This section provides information regarding the required database instances, the collation requirements, 

the recommended character sets, and recommended locations for the Stage, ODS, and Star database 

instances.  
 

Required Database Instances 

The following database instances must already exist: 

 A database instance for the Staging database (Stage) used during the ETL process. 

 A database instance for the ODS database. 

 A database instance for the Star database. 
 

Database Collation Requirements 

The database collation that you set when you create the Stage, ODS, and Star database instances must be 

the same for each. The collation must match the database collation set for the P6 EPPM database when it 

was created. 
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Note: If you choose not to install Star, these database collation requirements 

apply only to Stage and ODS. 

 

Character Set Requirements 

Oracle recommends using either UTF-8 or the WE8MSWIN1252 character set for P6 Reporting Database. 

The Oracle AL32UTF8 character set is not supported in Oracle P6 Reporting Database. 
 

Recommended Database Instance Locations 

It is recommended that the Stage, ODS and Star database instances reside on different physical machines 

from the P6 EPPM database. This minimizes the impact that the P6 Reporting Database has on the 

performance of the P6 EPPM database server. 

Note: If you choose not to install Star, these database instance locations apply 

only to Stage and ODS. 

 

Operating System User Permissions 

 To install P6 Reporting Database and run the files, the user for Windows must have full read/write 

access to the P6 Reporting Database installation directory. The user for non-Windows platforms should 

also have full read/write access to the P6 Reporting Database installation directory. 
 

Disk Storage Space Requirements 

This section provides information about the disk storage space requirements for the Stage, ODS, and Star 

databases. 
 

Stage Disk Storage Space Requirement 

The amount of disk storage space required for the Stage database is at least two times the size of the P6 

EPPM database. 
 

ODS Disk Storage Space Requirement 

The amount of disk storage space required for the ODS database is at most two times the size of the P6 

EPPM database. 
 

Star Disk Storage Space Requirement 

The amount of disk storage space required for the Star database varies greatly, based on the granularity of 

periodic data being accumulated. On average, this is half the size of the P6 EPPM database. 
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Bulk File Load Requirements 

When selecting a location for the bulk file load, ensure that several gigabytes of free space are available, 

since these files can become very large, depending on the size of your database. 
 

Creating the Oracle Tablespaces 

Before installing P6 Reporting Database, log onto SQL Plus as System\<system password> to create the 

Oracle tablespaces. 

Before creating the tablespace definitions, make sure that the Stage, ODS, and Star databases are in their 

proper locations. For more information, see Recommended Database Instance Locations (on page 21). 

When entering the tablespace definitions: 

 The single quotation marks must be entered. 

 You can change the path, depending on where Oracle tablespaces will be located. 

 All other information in the tablespace definition must be entered exactly as shown. 

 You must enter the semicolon at the end of the tablespace definition. 

Related Topics 

Creating the Stage Tablespace .............................................................................................................. 22 

Creating the ODS Tablespace ............................................................................................................... 22 

Creating the Star Tablespace ................................................................................................................. 23 

 
 

Creating the Stage Tablespace 

Before creating the Stage tablespace, see Creating the Oracle Tablespaces (on page 22) for important 

information about the code shown in the following procedure. Do the following to create the Stage 

tablespace: 

1) Connect to the P6 Reporting Database Stage instance with a user that has create tablespace privileges. 

2) Enter the following to create the Stage tablespaces (where <path> is the location of the Stage instance): 

Create tablespace stage_dat1 

       Datafile '<path>:\ stage_dat1.dbf' 

       Size 32m 

       Autoextend on 

       Extent management local uniform 1M; 

3) Set the db_block size to the following: 

db_block size = 32k 
 

Creating the ODS Tablespace 

Before creating the ODS tablespace, see Creating the Oracle Tablespaces (on page 22) for important 

information about the code shown in the following procedure. After logging onto SQL Plus as 

System\<system password>, do the following to create the ODS tablespace: 
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1) Connect to the P6 Reporting Database ODS instance with a user that has create tablespace privileges. 

2) Enter the following to create the ODS tablespaces (where <path> is the location of the ODS instance): 

Create tablespace ods_dat1 

       Datafile '<path>:\ ods_dat1.dbf' 

       Size 32m 

       Autoextend on 

       Extent management local uniform 1M; 

3) Set the db_block size to the following: 

db_block size = 32k 

 
 

Creating the Star Tablespace 

Before creating the Star tablespace, see Creating the Oracle Tablespaces (on page 22) for important 

information about the code shown in the following procedure. After logging onto SQL Plus as 

System\<system password>, do the following to create the Star tablespace: 

1) Connect to the P6 Reporting Database Star instance with a user that has create tablespace privileges. 

2) Enter the following to create the Star tablespaces (where <path> is the location of the Star instance): 

Create tablespace star_dat1 

       Datafile '<path>:\ star_dat1.dbf' 

       Size 32m 

       Autoextend on 

       Extent management local uniform 1M; 

3) Set the db_block size to the following: 

db_block size = 32k 
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This section describes the process for installing P6 Reporting Database software.  

In This Chapter 

Before Installing P6 Reporting Database ............................................................................................. 25 

Installation Procedure .............................................................................................................................. 25 

 
 

Before Installing P6 Reporting Database 

Before installing the P6 Reporting Database software: 

 Be sure you have met the installation prerequisites. See Prerequisites (on page 19). 

 The Oracle database instance must already exist before running the installation. See Required 
Database Instances (on page 20). 

 For either a Windows or a non-Windows system, the Oracle utility TNSPING must be in the path of 

the user who is running the installation in order for P6 Reporting Database to install successfully. 

Note: Due to the global nature of the Oracle Universal Installer (OUI), the OUI 

online help is not applicable for installing or uninstalling P6 Reporting Database, 

nor for references to the  documentation. Instead, refer to Installation 

Procedure (on page 25) for installation instructions. 

 

Installation Procedure 

Caution: P6 Reporting Database 2.1 must be installed in a new directory. Do 

not install P6 Reporting Database 2.1 in the same directory where a previous 

version of P6 Reporting Database is installed. 

Use the following procedure to install P6 Reporting Database:  

1) From the P6 Reporting Database physical media or download location, run one of the following 

depending on your system type: 

 If you are installing on a Microsoft Windows system: 

windows\Disk1\install\setup.exe 

 If you are installing on a non-Microsoft Windows system: 

<Operating System>\Disk1\install\runInstaller 

Where: <Operating System> is a supported non-Windows platform. For information on supported 

non-Windows platforms, see the Tested Configurations document (testedcfg.htm) on the release 

media or download. 

Installing the P6 Reporting Database Application 
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2) On the Welcome window, click Next. 

3) On the Specify Home Details window: 

a. Enter an appropriate name for P6 Reporting Database in the Name field. 

b. Click the Browse button next to the Path field to specify the installation location for P6 Reporting 

Database. 

c. Click Next. 

4) On the Java Runtime window, click the Browse button to specify the location of the JRE version (for 

example, c:\Program Files\Java\jre6).  

a. This must be a JRE location, not a JDK location.  

Note: The appropriate version of JRE must be installed on the machine where 

the ETL process will be run. For information on the specific JRE versions and 

supported operating system configurations, refer to the testedcfg.html 

document on the release media or download. 

b. If the location is a JDK location, select the JRE subfolder. 

c. Click Next to continue. 

5) Read the summary information that explains where P6 Reporting Database will be installed, what 

features will be installed, and the total size, and click Install. 

6) Prior to installation completion, the P6 Reporting Database configuration utility will launch in a separate 

window. 

 If P6 EPPM is on an Oracle instance, see Configuring the Software for Oracle Systems (on page 

27).  

 If P6 EPPM is on a Microsoft SQL Server system, see Configuring the Oracle Gateway for a 

Specific Microsoft SQL Server Database (on page 39) and Configuring the Microsoft SQL 

Server Connection (on page 41). 

7) After completing the P6 Reporting Database configuration utility, the End of Installation window 

displays. Click Exit to finish the installation. 
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This section describes how to configure the P6 Reporting Database for Oracle systems. If your P6 EPPM 

database is on a Microsoft SQL Server, follow the instructions in Configuring the Oracle Gateway for a 

Specific Microsoft SQL Server Database (on page 39). 

Note: During the configuration phase, some of the dialog boxes might already 

contain data. Check the data, and change it as necessary. 

 

In This Chapter 

Configuring the Oracle Connection ..................................................................................................... 27 

Configuring the Oracle Stage Database Connection ........................................................................ 28 

Configuring the Oracle ODS Database Connection ........................................................................ 28 

Configuring the Oracle Star Database Connection .......................................................................... 29 

Configuring Database Links .................................................................................................................... 30 

Configuring Java Virtual Machine, Bulk File Load, and Logging Settings ....................................... 30 

Configuring the Date Range Option ..................................................................................................... 31 

Configuring the Time-Distributed Data, Project Trend Interval, and Fiscal Year Start ........... 32 

Configuring Activity, Project, and Resource Codes ......................................................................... 33 

Finishing the Configuration ..................................................................................................................... 36 

Executing the RUNETL file to Complete the Installation ............................................................... 37 

 
 

Configuring the Oracle Connection 

In the P6 Reporting Database Configuration Utility, you will start with the PMDB tab, which will enable you 

to enter your Oracle connection information for your P6 EPPM database instance. Before configuring the 

Oracle connection information, see Before Installing P6 Reporting Database (on page 25). To see a 

description of the type of data a field requires, use your mouse to hover over the field. 

1) In the Connection Settings section, enter the P6 EPPM database instance connection information: 

a. Enter the Host Name. This is the machine name, or IP Address, of the Oracle server where the P6 

EPPM database instance resides. 

b. Enter the Port Number. This is the port number of the Oracle server where the P6 EPPM 

database instance resides. The default is 1521. 

c. In the Service Name field, enter the Oracle TNS Service Name of the P6 EPPM database instance. 

d. The JDBC URL field is automatically filled in based on the information you entered in the previous 

steps of this section. You cannot edit this field. 

e. The TNS Name field is automatically filled in based on the information you entered in the 

previous steps of this section. You cannot edit this field. 

Configuring the Software for Oracle Systems 
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2) In the Privileged section, enter the privileged username and password: 

a. Enter the Oracle privileged username. This is the Oracle user who can access and read from the P6 

EPPM database instance tables.   

b. Enter the password for the Oracle privileged user. This is the password for the Oracle user who 

can access and read from the P6 EPPM database instance tables.  

c. Click Next to go to the Stage tab. Use the fields on that tab to configure the Stage database 

connection settings, and Oracle connection settings for the Stage database. See Configuring the 

Oracle Stage Database Connection (on page 28). 
 

Configuring the Oracle Stage Database Connection 

You should now see the Stage tab, which will enable you to configure the Oracle connection settings for 

the Stage database instance. If your database instance is setup for case sensitive passwords, you must 

follow that convention for all passwords in the P6 Reporting Database configuration utility. 

1) In the Connection Settings section, enter the connection information for the Stage database: 

a. Enter the Host Name. This is the name or IP address of the Oracle server where the Stage 

database resides. 

b. Enter the Port Number. This is the port number of the Oracle server where the Stage database 

resides. The default is 1521. 

c. In the Service Name field, enter the Oracle TNS Service Name of the Stage database. The Service 

Name is used to connect to the database via JDBC. 

d. The JDBC URL field is automatically filled in based on the information you entered in the previous 

steps of this section. You cannot edit this field. 

e. The TNS Name field is automatically filled in based on the information you entered in the 

previous steps of this section. You cannot edit this field.  

2) In the System section, enter the Oracle system username and password: 

a. Enter the DBA Username. This is the username of the user who has DBA privileges for the Stage 

database. The default name is SYSTEM. 

b. Enter the DBA Password. This is the password of the user who has DBA privileges for the Stage 

database. 

3) In the Owner section, enter the Oracle table owner username and password: 

a. Enter the Stage Username. This is the username of the user who will own the Stage tables. This 

username does not currently exist. You must enter it to create it. The default is STAGEUSER. 

b. Enter the Stage Password. This is the password of the user who will own the Stage tables. 

c. In the Confirm Password field, enter the same password that you entered in step 3b to confirm 

the password.  

d. Click Next to go to the ODS tab. Use the fields on this tab to configure the ODS database 

connection settings. See Configuring the Oracle ODS Database Connection (on page 28). 
 

Configuring the Oracle ODS Database Connection 

You should now see the ODS tab, which will enable you to configure the Oracle connection settings for 

the ODS database instance. 
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1) In the Connection Settings section, enter the connection information for the ODS database: 

a. Enter the Host Name. This is the name or IP Address of the Oracle server where the ODS 

database resides. 

b. Enter the Port Number. This is the port number of the Oracle server where the ODS database 

resides. The default is 1521. 

c. In the Service Name field, enter the Oracle TNS Service Name of the ODS database. The Service 

Name is used to connect to the database via JDBC. 

d. The JDBC URL field is automatically filled in based on the information you entered in the previous 

steps of this section. You cannot edit this field. 

e. The TNS Name field is automatically filled in based on the information you entered in the 

previous steps of this section. You cannot edit this field. 

2) In the System section, enter the Oracle system username and password: 

a. Enter the DBA Username. This is the username of the user who has DBA privileges for the ODS 

database. The default name is SYSTEM. 

b. Enter the DBA Password. This is the password of the user who has DBA privileges for the ODS 

database. 

3) In the Owner section, enter the connection information for the table owner: 

a. Enter the ODS Username. This is the username of the user who will own the ODS tables.  

This username does not currently exist. You must enter it to create it.  

The default is ODSUSER. 

b. Enter the ODS Password. This is the password of the user who will own the ODS tables. 

c. In the Confirm Password field, enter the same password that you entered in step 3b to confirm 

the password. 

d. Click Next to go to the Star tab. On that tab: 

 If you purchased P6 Analytics, select the Install Star check box, and use the fields on that 

tab to configure the Star database connection. See "Configuring the Oracle Star Database 

Connection" in the P6 Analytics Administrator's Guide. 

 If you did not purchase P6 Analytics, clear the Install Star check box on the Star tab, and 

click Next to go to the Links tab. See Configuring Database Links (on page 30). 
 

Configuring the Oracle Star Database Connection 

Use the following procedure to configure the Star database for Oracle. 

1) Configure the Star database connection settings: 

a. Enter the Host Name. This is the name or IP Address of the Oracle server where the Star 

database resides. 

b. Enter the Port Number. This is the port number of the Oracle server where the Star database 

resides. The default is 1521. 

c. In the Service Name field, enter the Oracle TNS Service Name of the Star database. The Service 

Name is used to connect to the database via JDBC.  

d. The JDBC URL field is automatically filled in based on the information you entered in the previous 

steps of this section. You cannot edit this field. 
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e. The TNS Name field is automatically filled in based on the information you entered in the 

previous steps of this section. You cannot edit this field. 

2) In the System section, enter the Oracle Username and Password: 

a. Enter the DBA Username. This is the username of the user who has DBA privileges for the Star 

database. The default name is SYSTEM. 

b. Enter the DBA Password. This is the password of the user who has DBA privileges for the Star 

database.  

3) In the Owner section, enter the connection information for the table owner: 

a. Enter the Star Username. This is the username of the user who will own the Star tables. This 

username does not currently exist. You must enter it to create it. The default is STARUSER. 

b. Enter the Star Password. This is the password of the user who will own the Star tables.  

c. In the Confirm Password field, enter the same password that you entered in step 3b to confirm 

the password.  

d. Click Next to go to the LINKS tab. Use the fields on that tab to configure the database links. See 

Configuring Database Links (on page 30), 
 

Configuring Database Links 

Use the LINKS tab to enter the names of the database links to be created and used by the ETL process. A 

database link is a pointer that defines a one-way communication path from an Oracle Database server to 

another database server. The ETL process leverages the use of private database links to facilitate data 

transfer and to share information from one database to another. 

The fields are pre-filled with the default values, which you can change if necessary.  

On the LINKS tab: 

1) To change a default database link, enter the new value. Default values are:  

 STAGE to PMDB – Default value is: stage2pmdb 

 STAGE to ODS – Default value is: stage2ods 

 STAGE to STAR – Default value is: stage2star. This field is not available unless you choose to install 

Star. 

 STAR to STAGE – Default value is: star2stage. This field is not available unless you choose to install 

Star. 

 ODS to STAGE – Default value is: ods2stage 

2) When all fields contain the correct values, click Next to go to the Settings tab. Use the fields on that 

tab to configure general settings for the P6 Reporting Database. See Configuring Java Virtual 

Machine, Bulk File Load, and Logging Settings (on page 30). 
 

Configuring Java Virtual Machine, Bulk File Load, and Logging Settings 

Use the Settings tab to choose the locations for the Java Virtual Machine (JRE path), the Bulk File Load 

files, and to select the level of logging. 

1) In the Java Virtual Machine section, choose the Java Virtual Machine location and Maximum Java Heap 

Size: 
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a. In the Location field, enter the path to the Java Virtual Machine (JRE path).  

 The appropriate version of JRE must be installed on the machine where the ETL process will 

be run. For information on the specific JRE versions and supported operating system 

configurations, refer to the testedcfg.html document on the release media or download.  

 The path must refer to a location on the local machine, where the P6 Reporting Database 

configuration utility is installed. 

b. Enter the Maximum Java Heap Size (MB) parameter. This value maps to the JVM –Xmx setting 

in the Java Runtime Environment settings. The default value is 1,024 MB.  

 The minimum value is 512 MB.  

 When changing the Maximum Java Heap Size setting, the values must be in 512 MB 

increments. 

2) Choose the Bulk File Load location: 

a. In the Bulk File Load section, manually enter the path to the location for P6 Reporting Database bulk 

load files, or use the Browse button to select its location. 

 The bulk load file location is the location where P6 Reporting Database stores files needed 

during processing.  

 These files contain hierarchy and spread bulk load data.  

 Oracle recommends that read and write privileges to this directory only be granted to users 

who will run the ETL or Incremental process. 

b. When selecting the location, ensure that several gigabytes of free space are available, since these 

files can become very large, depending on the size of your database. 

3) In the Logging section, choose the level of logging detail that you want to use. The following are the 

logging detail levels from which you can choose: 

 Errors Only – Only logs errors and no other information. 

 Errors and Warnings – Only logs errors and warnings and no other information. 

 General Information – This is the default value. This logs errors, warning, and informational 

messages on the progress of each step. 

 Extra Debug Information – Provides all general information, errors and warnings. It provides 

more fine grained information on each step and scripts being executed. 

 Debug and Trace Information – Provides all general information, errors and warnings, and 

detailed output of each script, query, and connection being executed. 

4) Click Next when finished to go to the Options tab.  

a. Use the Options tab to configure the Date Range option.  

b. See Configuring the Date Range Option (on page 31). 
 

Configuring the Date Range Option 

Use the Options tab to configure the Date Range, Time-Distributed Data, Project Trend Interval, and 

Fiscal Year Start for your P6 Reporting Database. 

The date range sections allows users to specify the start and end date for the detailed spread data within 

your P6 Reporting Database. The start date corresponds to the date your spread data will begin. 
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Any data that occurs outside of the start date will be lump summed on your start date. (For example, if the 

start date is set for January 1, 2010 any data in the P6 EPPM database that occurs prior to January 1, 2010, 

will be lump summed on January 1, 2010.) 

The end date is a "rolling" window that corresponds to a future date based on the date the ETL or 

Incremental process is run. (For example, if the end date is set to 1 year and Incremental update is executed 

on April 9, 2010, any data in the P6 EPPM database that occurs after April 9, 2011 will be lump summed and 

placed on April 9, 2011.) 

To configure the Date Range option, do the following: 

1) In the Date Range section of the Options tab, choose the Start and End Date options: 

a. Use the calendar icon next to the Start Date field to select the date on which you want your 

spread data to start. 

b. For End Date, select a rolling interval based upon the date the ETL or Incremental process is run. 

2) Do one of the following: 

 If you purchased P6 Analytics, click Next and then configure the Project Trend Interval and the 

Fiscal Year Start. See Configuring the Time-Distributed Data, Project Trend Interval, and 

Fiscal Year Start (on page 32) in the P6 Analytics Administrator's Guide.  

 If you did not purchase P6 Analytics, click Next and then finish the configuration. See Finishing the 

Configuration (on page 36).  
 

Configuring the Time-Distributed Data, Project Trend Interval, and Fiscal Year Start 

Use the Options tab to configure the Time-Distributed Data, Project Trend Interval, and Fiscal Year Start 

for P6 Reporting Database. This will be used by P6 Analytics.  

The Time-Distributed Data interval enables you to determine the degree of granularity that you want to 

use to view Activity and Resource Assignment Unit and Cost distribution. This can be daily (day to day) or 

weekly (week to week).  

The Project Trend interval corresponds to the interval in which your project history data is collected. If you 

do not run your incremental process at the end of the interval, any data that occurred since the last time 

you ran the incremental process will be collected into the next interval. 

For example, if you select Month as your Project Trend interval, and execute the incremental process on 

November 20, all project data from your previous incremental run, up to and including November 20, 

would be stored in the November interval. If you do not run your incremental process again until 

December 8, all the data from November 21 through December 8 will appear within the December 

interval. It will not appear in the November interval, because there is no retrospective process for putting 

it into a previous interval. 

By setting the Fiscal Year Start, users can view data by Fiscal Year. If Fiscal year is not used, leave Fiscal Year 

Start at the default value of January 1. 

To configure the Time-Distributed Data, Project Trend Interval, and Fiscal Year Start, do the following: 

1) In the Time-Distributed Data section of the Options tab, choose the data spread  Interval. This 

can be Day or Week. 

2) In the Project Trend section of the Options tab, choose the Project Trend Interval. This can be 

one of the following: 
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3)  

Note: In order to use one of the Financial Periods, these must already have been 

defined. 

 Week 

 Month 

 Quarter 

 Year 

 Financial Period 1 (This is the Financial Period from the P6 EPPM Database.) 

 Financial Period 2 (This is a custom Financial Period.) 

 Financial Period 3 (This is a custom Financial Period.) 

4) In the Fiscal Year Start section: 

a. Use the Month list to choose the month in which the Fiscal Year starts. 

b. Use the Day list to choose the day in the month on which the Fiscal Year starts. 

5) Click Next to go to the Codes tab. Use that tab to add Activity, Project, or Resource codes. See 

Choosing Activity, Project, or Resource Codes (on page 69).  
 

Configuring Activity, Project, and Resource Codes 

Use the Codes tab to choose the Oracle Business Intelligence (OBI) Activity, Project, and Resource 

dynamic code mappings that you will use for P6 Reporting Database. 

A maximum of 20 code mappings is allowed for each code type. For information on how these codes work, 

see the "Dynamic Codes" section of the P6 Reporting Database User's Guide or the P6 Analytics User’s Guide. 

This tab has three subordinate tabs: 

 Activity 

 Project 

 Resource 

Related Topics 

Choosing Activity Codes ........................................................................................................................ 33 

Choosing Project Codes ......................................................................................................................... 35 

Choosing Resource Codes ..................................................................................................................... 35 

When You Finish Adding Activity, Project, and Resource Codes ................................................ 36 

 
 

Choosing Activity Codes 

Use the Activity tab to choose the Activity codes you want to use with P6 Reporting Database and P6 

Analytics. These codes must already exist in the P6 EPPM database.  

Because activity codes can be defined for different areas of your P6 EPPM database (Global, EPS, and 

Project), P6 Reporting Database enables you to define the Scope in which these activity codes are used.  
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The scope order is important because it determines a tie-breaker if there is a code with the same name at 

different levels.  For example, if there is a global code called MyCode, and a project has a code called 

MyCode, the scope setting used would determine which code value is used.  If you select Project, 

Global, then the global MyCode value will be used. If you select Project, Global as the scope setting, then 

the project level MyCode value will be used. 

For a description of the Activity tab fields, see Activity Code Descriptions (on page 34). 

Repeat the following for each activity code you want to add: 

1) Click Add on the Activity tab, and then click in the Matching Criteria column. 

2) Choose the Activity code from the list. 

3) Click Scope, and then choose the scope for the Activity code from the list. 
 

Activity Code Descriptions 

The Activity tab has the following fields: 

Field Description 

Code Contains the Activity code number. When you choose an Activity 

code, this is assigned sequentially starting with number 1. 

Scope Use the scope list to choose one of the following: 

 

 Global 

 Global, EPS 

 Global, Project 

 Global, EPS, Project 

 Global, Project, EPS 

 EPS 

 EPS, Global 

 EPS, Project 

 EPS, Global, Project 

 EPS, Project, Global 

 Project 

 Project, EPS 

 Project, Global 

 Project, EPS, Global 

 Project, Global, EPS 

Matching Criteria This field can be used to select a code value from the P6 EPPM 

database. In addition, this field allows the use of regular 

expression syntax for a more flexible code definition, if necessary. 

Name This field corresponds to the code value in the P6 EPPM database. 

If you leave this field blank, it automatically populates with an 

initial value. This field can be edited. 
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Description This field corresponds to the Activity code description in the P6 

EPPM database. If you leave this field blank, it automatically 

populates with an initial value. This field can be edited. 

 
 

Choosing Project Codes 

Use the Project tab to choose the Project codes you want to use with P6 Reporting Database and P6 

Analytics. These codes must already exist in the P6 EPPM database. Project codes are not global, and have 

no scope. 

For a description of the Project Codes, see Project Code Descriptions (on page 35). 

Repeat the following for each project code you want to add: 

1) Click Add on the Project tab, and then click in the Matching Criteria column. 

2) Choose the Project code from the list. 
 

Project Code Descriptions 

The Project tab has the following fields: 

Field Description 

Code Contains the Project code number. When you choose a Project 

code, this is assigned sequentially starting with number 1. 

Matching Criteria This field can be used to select a code value from the P6 EPPM 

database. In addition, this field allows the use of regular 

expression syntax for a more flexible code definition if necessary.  

Name This field corresponds to the Project Code value in the P6 EPPM 

database. If you leave this field blank, it automatically populates 

with an initial value. This field can be edited. 

Description This field corresponds to the Project Code description in the P6 

EPPM database. If you leave this field blank, it automatically 

populates with an initial value. This field can be edited. 

 
 

Choosing Resource Codes 

Use the Resource tab to choose the Resource codes you want to use with P6 Reporting Database. These 

codes must already exist in the P6 EPPM Database. Resource codes are not global, and have no scope. 

For a description of the Resource Codes, see Resource Code Descriptions (on page 36). 



P6 Analytics Administrator's Guide  

 

36 

 

Repeat the following for each resource you want to add: 

1) Click Add on the Resource tab, and then click in the Matching Criteria column. 

2) Choose the Resource code from the list. 
 

Resource Code Descriptions 

The Resource tab has the following fields. 

Field Description 

Code Contains the Resource code number. When you choose a 

Resource code, this is assigned sequentially starting with number 

1. 

Matching Criteria This field can be used to select a code value from the P6 EPPM 

database. In addition, this field allows the use of regular 

expression syntax for a more flexible code definition if necessary. 

Name This field corresponds to the Resource code value in the P6 EPPM 

database. If you leave this field blank, it automatically populates 

with an initial value. This field can be edited. 

Description This field corresponds to the Resource code description in the P6 

EPPM database. If you leave this field blank, it automatically 

populates with an initial value. This field can be edited. 

 
 

When You Finish Adding Activity, Project, and Resource Codes 

After you finish choosing Activity, Project, and Resource codes, click Next to go to the Complete tab. 

See Finishing the Configuration (on page 36). 
 

Finishing the Configuration 

After choosing the Activity, Project, and Resource codes, click Finish on the Complete tab to complete 

the configuration. This generates all the scripts that go into the scripts directory. 

All the settings configured with the P6 Reporting Database configuration utility will be stored in the 

following location: 

     <installation path>\p6rdb\res\erdb.properties 

This file is a Java properties file, which is a simple key = value storage file. For example: 

     db.stage.application.username=STAGEUSER 
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Executing the RUNETL file to Complete the Installation 

After you complete the installation and all configuration tasks, execute the RUNETL.bat (or RUNETL.sh) 

file to begin the ETL process.  

To do this: 

1) Go to the <installation directory name> directory. 

2) Click RUNETL.bat (or RUNETL.sh) to execute the file. 
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This section describes how to configure the Oracle Gateway to link the P6 EPPM database located on the 

Microsoft SQL Server. 

It describes the process for configuring the P6 EPPM database connection information when the P6 EPPM 

database is on a Microsoft SQL Server. 

In This Chapter 

Configuring the Oracle Gateway for a Specific Microsoft SQL Server Database ..................... 39 

Configuring the Microsoft SQL Server Connection ......................................................................... 41 

 
 

Configuring the Oracle Gateway for a Specific Microsoft SQL Server Database 

If your P6 EPPM database is a Microsoft SQL Server database, do the following to configure the Oracle 

Gateway to use that database: 

For information on installing the Oracle Gateway, see Oracle Gateway Installation Requirements (on 

page 19).  

1) Go to the <Oracle Gateway install directory>\dg4msql\admin folder. 

 <Oracle Gateway install directory> is the directory where you installed the Oracle Gateway. 

 The dg4msql\admin folder was created when you installed the Oracle Gateway. 

2) Open the initdg4msql.ora file and edit the HS_FDS_CONNECT_INFO= parameter to be in the 

format: 

 HS_FDS_CONNECT_INFO=<servername>/<instancename>/<pmdbdatabase> 

Where: the < > brackets indicate the variables that you enter. Do not enter the brackets as part of the 

variable name. 

For example: 

HS_FDS_CONNECT_INFO=win2k2/sqlserver/pmdb 

The following example shows the parameter when an instancename is not specified: 

HS_FDS_CONNECT_INFO=serverSQL//proj_pmdb 

3) In the <Oracle Gateway install directory>, go to the ADMIN folder, and add a new TNSnames entry for 

each new SQLServer Gateway. For example: 

      dg4msql = 

      (DESCRIPTION= 

      (ADDRESS=(PROTOCOL=tcp)(HOST=<server name>)(PORT=1521)) 

      (CONNECT_DATA=(SID=dg4msql)) 

Configuring the Oracle Gateway to Link to a P6 EPPM 

Database on a Microsoft SQL Server System 



P6 Analytics Administrator's Guide  

 

40 

 

      (HS=OK) 

      ) 

      dg4msql1 = 

      (DESCRIPTION= 

      (ADDRESS=(PROTOCOL=tcp)(HOST=ServerName)(PORT=1521)) 

      (CONNECT_DATA=(SID=dg4msql1)) 

      (HS=OK) 

      ) 

4) In the same directory, edit Listener.Ora, and add information for each necessary gateway. For example: 

      (SID_LIST= 

      (SID_DESC= 

      (SID_NAME=dg4msql) 

      (ORACLE_HOME=C:\product\11.1.0\tg_1) 

      (PROGRAM=dg4msql) 

      ) 

      (SID_DESC= 

      (SID_NAME=dg4msql1) 

      (ORACLE_HOME=C:\product\11.1.0\tg_1) 

      (PROGRAM=dg4msql) 

      ) 

      (SID_DESC= 

      (SID_NAME=dg4msql2) 

      (ORACLE_HOME=C:\product\11.1.0\tg_1) 

      (PROGRAM=dg4msql) 

      ) 

      ) 

5) Stop any existing Listeners on the Oracle Gateway server. 

6) If you need to connect to other Oracle instances, you must configure the TNS Names in the directory 

where you installed the Oracle Gateway. 

7) Start the Gateway Listener. The necessary Stage tablespace size is 30 GB, while allowing an extent size 

of uniform 2MB. The following Initialization parameters were set for the Gateway: 

 HS_RPC_FETCH_SIZE=1000000 

 HS_ROWID_CACHE_SIZE=10000 

 HS_FDS_ROW_SIZE=50000 

For a dataset with similar statistics: 

 TASK - 6 million rows 

 TASKACTV - 15 million rows 

 TASKRSRC - 9 million rows 

 UDFVALUE - 3 million rows 

 RSRCHOUR - 50 million rows 
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 PROJWBS - 2 million rows 

8) When configuring your Oracle Gateway, set HS_LANGUAGE for the Oracle character set of your 

instance: 

a. On the gateway machine, go to the gateway install directory (for example, 

C:\product\11.1.0\tg_2\dg4msql\admin) 

b. Edit the initdg4msql ini file, and add the following parameter specific to your Oracle dataset. 

Depending on your character set, either add the following or adjust for UTF8: 

     HS_LANGUAGE=american_america.WE8ISO8859P15 

Or, add all of the following: 

     HS_NLS_LENGTH_SEMANTICS=CHAR 

     HS_FDS_CHARACTER_SEMANTICS = TRUE 

     HS_KEEP_REMOTE_COLUMN_SIZE=ALL 

c. Save the initdg4msql ini file, and restart the Gateway listener. 
 

Configuring the Microsoft SQL Server Connection 

Use the following instructions if your P6 EPPM database is on a Microsoft SQL server. You must have 

already installed the Oracle Gateway software before installing the Primavera P6 Reporting Database 

software. For information about installation, see see Oracle Gateway Installation Requirements (on 

page 19).  

1) In the Connection Settings - (Oracle Gateway) section, enter the P6 EPPM database connection 

settings: 

a. Select the PMDB is on SQL Server option. 

b. Enter the Host Name (in the field at the top of the dialog box). This is the machine name or IP 

address of the Oracle server on which you want to create the Oracle Gateway. 

c. Enter the Port Number (in the field at the top of the dialog box). enter the Service name of the 

Oracle server on which you want to create the Oracle Gateway. 

Note: The JDBC URL and TNS fields at the top of this dialog box are read-only 

fields. 

d. Enter the Database Name. This is the name of the P6 EPPM database on the Microsoft SQL 

Server. This database must already exist. 

e. Enter the Host Name. This is the full SQL Server instance name of the Microsoft SQL Server 

where the P6 EPPM database resides. For example: 

       SQLServerName\databaseInstanceName 

Note: If there is a named database instance, both the server name and the 

instance name must be included. 

f. Enter the Port Number. This is the port number of the Microsoft SQL Server where the P6 EPPM 

database resides. The default is 1433. 

g. The JDBC URL field is read-only. You cannot edit this field. 

2) In the Privileged section: 
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a. In the Username field, enter the Privileged user logon name for the P6 EPPM database on the 

Microsoft SQL Server. 

b. In the Password field, enter the Privileged user logon password for the P6 EPPM database on the 

Microsoft SQL Server. See Configuring the Oracle Stage Database Connection (on page 28).  

c. Click Next to go to the Stage tab. Use the fields on that tab to configure the Stage database 

connection settings, and Oracle connection settings for the Stage database.  

d. From this point on, follow the steps described in Configuring the Software for Oracle Systems 

(on page 27), starting with Configuring the Oracle Stage Database Connection (on page 28). 
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This section describes the process for upgrading to P6 Reporting Database R2.1 from P6 Reporting 

Database R2 and R1 for Oracle 10g and 11g. 

There is no upgrade path if P6 Reporting Database is installed on a Microsoft SQL Server system. 

Note: P6 Reporting Database 2.1 must be installed in a new directory. Do not 

install P6 Reporting Database 2.1 in the same directory where a previous version 

of P6 Reporting Database is installed. 

 

In This Chapter 

Upgrade Installation If the Previous Version Included Star ............................................................. 43 

Upgrade Installation If the Previous Version Did Not Include Star .............................................. 44 

 
 

Upgrade Installation If the Previous Version Included Star 

Use the following procedure to upgrade to the latest version if the previous version of P6 Reporting 

Database was installed to include Star. 

Note: There is no upgrade path if P6 Reporting Database is installed on a 

Microsoft SQL Server system. 

1) Upgrade your P6 EPPM database to P6 EPPM 8.0. 

2) Follow the installation procedure (on page 25), and install P6 Reporting Database either to the same 

location where your previous version is installed.  

3) Use the information in the topics in the Configuring the Software for Oracle Systems section to 

configure the P6 Reporting Database for Oracle. 

4) If you are upgrading from versions R2, or R1, do the following: 

a. Drop the following user: 

Drop user prmcdc cascade; 

b. Go to the \scripts folder, and run upgrade.bat (or upgrade.sh when upgrading from a 

non-windows system) to upgrade the Stage and ODS databases.  

c. Go to the \scripts folder, and run upgrade_star.bat (or upgrade_star.sh when upgrading from 

a non-windows system) to upgrade the Star database.  

d. Go to step 6.   

5) If you are upgrading from P6 Reporting Database R2 and P6 Analytics R1, run upgrade_70.bat (or 

upgrade_70.sh when upgrading from a non-windows system) to upgrade the Stage, ODS, and Star 

databases. 

Upgrade P6 Reporting Database to the Latest Version 
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6) In the \scripts folder, run incremental.bat (or incremental.sh when upgrading from a 

non-windows system). 
 

Upgrade Installation If the Previous Version Did Not Include Star 

If you are upgrading from P6 Reporting Database R2 or R1, and did not install the Star database in that 

version, use the following procedure to upgrade to the latest version.  

Note: There is no upgrade path if P6 Reporting Database is installed on a 

Microsoft SQL Server system. 

1) If you purchased P6 Analytics, create the Star Tablespaces. For more information, see "Creating the 

Star Tablespaces" in the P6 Analytics Administrator's Guide. Otherwise, go to step 2. 

2) Upgrade the P6 EPPM database to the 8.0 version. 

3) Follow the installation procedure (on page 25), and install P6 Reporting Database. You can either 

install the software to the same location where your previous version is installed.  

4) Use the information in the topics in the Configuring the Software for Oracle Systems section to 

configure the P6 Reporting Database for Oracle. 

5) Drop the following user: 

Drop user prmcdc cascade; 

6) Go to the \scripts folder, and run upgrade.bat (or upgrade.sh when upgrading from a 

non-windows system) to upgrade the Stage and ODS databases.  

7) If you purchased P6 Analytics, do the following: 

a. Go to the \scripts folder, and run create_star.bat (or create_star.sh when upgrading from a 

non-windows system) to create the Star database.  

b. Go to the \scripts folder, and run loadstar.bat (or loadstar.sh when upgrading from a 

non-windows system). 

8) In the \scripts folder, run incremental.bat (or incremental.sh when upgrading from a 

non-windows system). 
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Describes the general administrative tasks, including how to secure the ERDB.properties file, how to clear 

and refresh data, and how to schedule or manually launch an incremental database update. 

 

In This Chapter 

Securing the ERDB.properties File ........................................................................................................ 45 

Clearing and Refreshing the Data.......................................................................................................... 45 

Scheduling the Incremental Database Update .................................................................................... 46 

Manually Launching the Incremental Database Update .................................................................... 46 

Using Reports from a Previous Version .............................................................................................. 47 

 
 

Securing the ERDB.properties File 

 This section contains information you need when securing the ERDB.properties file.  

Ensure that only the user running the P6 Reporting Database scripts or processes has access to the 

ERDB.properties file, which is located in the following folder: 

      <installation path>\p6rdb\res 

Only trusted users should have access to these files or folder. 

File system protection can be set on all of the supported operating systems. Based on the settings applied, 

the \res folder can be password protected or hidden. A new user can be created with the least amount of 

permissions to this file and folder. Do not give any other user access to this location. 

For options for operating system-specific security, either contact your local administrator or search for file 

system security for your specific operating system. 
 

Clearing and Refreshing the Data 

There are times when you might need to clear and refresh all the data in the Stage, ODS, and Star databases. 

It is not necessary to uninstall and reinstall P6 Reporting Database to accomplish this task. 

The following procedure assumes that you chose the default usernames (STAGEUSER, STARUSER, and 

ODSUSER) during the installation. If you choose different names, substitute those names for the defaults. 

1) Login to the P6 Reporting Database instance with a user account that has the Drop User system 

privilege (such as System). 

2) Run the following commands: 

a. drop user stageuser cascade; 

b. drop user odsuser cascade; 

Administrative Tasks 
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c. drop user staruser cascade; 

Caution: Deleting the Star database will also delete the project History Fact 

data that was accumulated. 

3) Run the following to drop the public synonyms for P6 EPPM data: 

begin 

for syndrop in (select synonym_name from all_synonyms where synonym_name like 'P6%') 

loop  

execute immediate 'drop public synonym '||syndrop.synonym_name; 

end LOOP ; 

end; 

Dropping the users listed in step 2 of the preceding procedure will remove all data from the P6 Reporting 

Database instance. You can rerun one of the following files to populate the Stage, ODS, and Star databases 

with the P6 EPPM database information: 

 runetl.bat (on a Windows system) 

 runetl.sh (on a supported non-windows system)  

 
 

Scheduling the Incremental Database Update 

Using a System Task Scheduler to Schedule Recurring ETL Jobs 

To keep the ODS and Star databases current, the Incremental ETL process must be run periodically. 

Typically, this is done nightly during off hours. 

Schedulers exist for both Windows and non-Windows operating systems. For Windows operating 

systems, the Windows Task Scheduler can be used. For non-Windows operating systems, this is done 

through a cron job using the Crontab command. Please refer to your operating system documentation for 

specifics on how to configure Incremental to run as a recurring job. 

Caution: When configuring the scheduler, Oracle recommends that you select 

the option to not start the next job until the previous job has completed. 

 

Manually Launching the Incremental Database Update 

To launch the Incremental database update for ODS and Star, execute one of the following files on the 

machine where Stage is installed: 

 incremental.bat (on a Windows platform) 

 incremental.sh (on a non-Windows platform) 

The account used to launch the file must have administrative privileges on the machine. 
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Using Reports from a Previous Version 

If you have reports that were created in a previous version, you can use them in P6 Reporting Database by 

doing the following to create backward-compatible views for them: 

1) Go to the \p6rdb\scripts folder. 

2) Connect as ODSUSER to SQL Plus, and execute the script  ods_security_views_70.tsql to create 

views. 

3) Connect as system to SQL Plus, and execute the following: 

grant create any synonym to odsuser;  

Where: odsuser is the name of the ODS schema owner.  This is necessary in order to create 

synonyms in other users' schemas. It is only granted for backward-compatible views. 

4) To create backward-compatible views for all users, execute the stored procedure CREATEERUVIEWS 

through SQL Plus.   

 You can pass in a list of users, separated by commas. 

 If you run the procedure without specifying usernames, it will generate synonyms for each 

reporting user.  

a. To Run through SQL DEVELOPER, run the stored procedure and then edit the following: 

BEGIN 

      USERLIST := NULL; 

CREATEERUVIEWS(USERLIST 

); 

Change the preceding code to be: 

BEGIN 

      USERLIST := NULL; 

CREATEERUVIEWS( 

); 

New users are created based on whether Enterprise Reports module access is set in the P6 EPPM 

database for the username.  

b. To create backward-compatible views only for certain users, run the stored procedure and edit the 

following: 

BEGIN 

          USERLIST := NULL; 

Remove the word NULL, and set values for the usernames you want created. For example: 

BEGIN 

             USERLIST := 'eruser,eruser2'; 

5) Connect to P6 as the appropriate database user. Under Views, you should see the names of the views 

from the P6 Reporting Database R2 and P6 Analytics R1 release.  
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This section describes the ODS security configuration tasks. These include adding a new user, modifying 

user access, and deleting an existing user.  

In This Chapter 

User-Level Security and Username Restrictions ............................................................................... 49 

Adding a New ODS User........................................................................................................................ 50 

Modifying User Access in ODS .............................................................................................................. 50 

Deleting an ODS User ............................................................................................................................. 51 

 
 

User-Level Security and Username Restrictions 

In order for the ODS to properly implement P6 EPPM user-level security, a database-level user will be 

created in ODS if marked as a reporting user in P6 EPPM. The P6 EPPM username must conform to the 

following restrictions: 

 It must be 30 or less characters in length. 

 If it contains any special characters (such as @ # $  % ,  ^ & * . (  ) - + \ / : _ ;  | < >, etc.), these 

automatically will be removed. For example, if the P6 EPPM user name is johnd@company.org, the 
ODS database user that is created for it will be: 

johndcompanyorg. 

 It must not contain any embedded spaces. 

 It must start with a letter, not a number. 

 It cannot start with a numeric character if created in P6 EPPM for users who will also use P6 

Reporting Database. 

 It must start with an alphabetic character. User names that start with numbers cannot be used as 

database-level login names. 

 It must have at least one character. 

These restrictions are required because of the way security must be implemented in the ODS and applied 

to the Oracle database. 

Database views are created for the ODS tables. Public synonyms are created and then the ODS database 

users are given access to these synonyms. When the ODS database user accesses the tables, row, and fields 

through these synonyms a filter is applied to allow data to be that meets this users' access based on their P6 

EPPM security attributes. 

If the user is an application user in the P6 EPPM database, and has Enterprise Reports module access set, a 

database login for the user will be created in the Oracle instance of the ODS database. This user will have 

the same password as the application user in the P6 EPPM application. 

ODS Security Configuration 
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In order for a user to log into the ODS database directly (for example, using SQL Plus) with the P6 EPPM 

user name, a system database administrator must first reset the ODS database user's password. 
 

Adding a New ODS User 

When adding a new user, the username must conform to the format restrictions listed in User-Level 

Security and Username Restrictions (on page 49).  

For detailed information on adding a new P6 EPPM user, see the P6 EPPM Administrator’s Guide, or the P6 

EPPMOnline Help.  

For detailed information on ODS security, see the P6 Reporting Database User's Guide or the P6 Analytics 

User’s Guide. 

Use the following procedure to add a new user for the ODS: 

1) Login to the P6 EPPM database via P6, and add a new ODS user.  

 This ODS username must start with an alphabetic character.  

 It must also conform to the username format restrictions described in User-level security and 

username restrictions. 

2) Configure the user's P6 EPPM security attributes. 

3) In P6, assign Enterprise Reports module access.  

4) On the machine where the Stage database resides, run one of the following files: 

 incremental.bat (on a Windows platform) 

 incremental.sh (on a non-Windows platform) 

This file is in the <P6 Reporting home>\p6rdb for incremental directory. This adds the user to the ODS 

database, creates Views for the user, and adds the user to Server Logins. 

When the ETL process or incremental.bat (or incremental.sh for non-Windows systems) is run, a new 

database user will be created in the ODS instance.  

 The user will be given role privileges to the P6Reports role. The password for that database user 

must be manually altered in order for the user to be able to connect directly as that user.  

 The P6Reports role enables the user to connect and query the public synonyms for 'P6%'. 
 

Modifying User Access in ODS 

Users given access to the ODS will only be able to access the data for which they have rights in the P6 EPPM 

database. 

For example, if a user has the “View Project Costs/Financials” privilege in the P6 EPPM database, then that 

user will be able to view project cost information in the ODS. Conversely, if a user does not have the “View 

Project Costs/Financials” privilege in the P6 EPPM database, they would see the word null in place of the 

value in fields that contain cost information. 

Use the following procedure to give a user the ability to view cost information. 

1) In the P6 EPPM application, access the Admin, Security Profiles dialog box. 

2) To provide access to cost information, ensure that the "View Project Costs/Financials" privilege option 

is selected in the users project profile. 
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3) There is a global profile privilege that will enable users to view resources costs if the user has resource 

access. To enable this feature, ensure that the View Resource and Role Costs option is selected. 

4) On the machine where the Stage database resides, run one of the following files: 

 incremental.bat (on a Windows platform) 

 incremental.sh (on a non-Windows platform) 

This file is in the <P6 Reporting Database home>\p6rdb for incremental directory. 
 

Deleting an ODS User 

Use the following procedure to delete a user from ODS.  

1) In the P6 application, remove Enterprise Reports from the user's module access.  

2) On the machine where the Stage database resides, run one of the following files: 

 incremental.bat (on a Windows platform) 

 incremental.sh (on a non-Windows platform) 

This removes the create a session privilege, and removes access to the public synonyms for the 

database user. 

3) The Oracle ODS user that was created will still exist in the ODS instance.   

 This user will be disconnected from any views pertaining to ODS tables.  

  This user can be dropped from the ODS instance by executing the following query as the 

Oracle Instance system account or a user with permissions to drop other database users: 

          Drop user deleteUserName cascade; 

For information on deleting a P6 EPPM user, see the P6 EPPMAdministrator’s Guide, or the P6 EPPM online 

help.  

For additional information on ODS security see the P6 Reporting Database User's Guide or the P6 Analytics 

User’s Guide. 
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This section describes the Star security configuration. These include adding a new Star user, setting up 

security, and filtering out inactive resources.  

 

In This Chapter 

Adding a New Star User ......................................................................................................................... 53 

Setting Up Star Security ........................................................................................................................... 53 

Filtering Out Inactive Resources ........................................................................................................... 54 

 
 

Adding a New Star User 

This topic describes how to add a new Star user.  

1) In P6 EPPM, do the following: 

a. Add a new user, and give the user module access to any of the following modules. Be sure to grant 

the user the necessary OBS, cost, and resource access: 

 P6 Analytics 

 Web Access Portfolios 

 Web Access Projects 

 Web Access Resources 

b.    Run the full ETL process or the incremental process. 

2) In Oracle Business Intelligence (OBI), do the following: 

a. Open the OraclePrimaveraP6Analytics.rpd with the OBI  

Administration tool. 

Note: The default password for the OraclePrimaveraP6Analytics.rpd file is 

PMADMIN.  

b. Add the matching user name by accessing Manage, Security and adding the users to the users 

section. The OBI password does not have to match the P6 EPPM user name. 

If OBI and P6 EPPM are both configured to use LDAP authentication, users do not need to be created 

manually. Only the LDAP server needs to be added to OraclePrimaveraP6Analytics.rpd by accessing 

Manage, Security. See the OBI documentation information about configuring LDAP for OBI. 
 

Setting Up Star Security 

In order for users to have access to the Star database, they must have module access rights configured in 

the P6 EPPM database. OBI Users must already be configured in OBI. 

Star Security Configuration 
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The following table describes the Star security: 

Type Description 

OBS Access Users who have OBS access in the P6 EPPM module will have 

OBS access in OBI. 

View Project Costs/Financials Users who have access to projects in the P6 EPPM database, and 

who have this privilege set, will have the same privilege in the 

Star database. 

Resource Access Resource access can be set to one of the following: 

 All resource access - The user will have unrestricted 
access to resources. 

 None - The user cannot access any resources. 

 Specific resource access - The user can only access a 
specific resource. 

 
 

Filtering Out Inactive Resources 

Filtering Out Inactive Resources 

By default, inactive resources are filtered out of the Star tables. If inactive resources were included, they 

would also be included in the spread data and in other dimension tables.  It might not be necessary to 

process this extra resource assignment information. 

If you do want to include inactive resources in the Star tables, update the following setting in the 

erdb.properties file, and set the =false parameter  to =true: 

       star.utilization.include.inactive.rsrc=false 
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Overview of BI Publisher Administration Tasks 

BI Publisher is an Oracle enterprise reporting solution that can be used with the ODS. For complete 

overview information about BI Publisher, go to the following web site: 

http://www.oracle.com/technology/products/xml-publisher/index.html 
 

Installing Oracle Business Intelligence Publisher 

For information on installing the Oracle Business Intelligence Publisher, go to the following web site: 

http://www.oracle.com/us/solutions/ent-performance-bi/bi-publisher-066551.html 
 

Configuring the JDBC Connection 

Logon to the BI Publisher, and do the following: 

1) Click the Admin tab. 

2) Under Data Sources, click the JDBC Connection link. 

3) Click the Add Data Source button. 

4) Add the database connection information, and save the settings. 
 

Configuring BI Publisher Security 

Logon to BI Publisher, and do the following: 

1) Click the Admin tab. 

2) Under Security Center, click the Security Configuration link. 

3) In the Local Superuser section, do the following to configure the name and password of the Local 

Superuser. 

a. Select the Enable Local Superuser option. 

b. In the Superuser name field, enter the Superuser‟s name. 

c. In the Password field, enter the Superuser‟s password. 

BI Publisher Administration Tasks 
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 Note: Oracle BI Publisher enables an administrator to setup a security 

model based on roles and permissions. These roles and permissions can be 

enforced on folders containing reports created from ODS data. For more 

information, see "Defining a Security Model" in the Oracle Business Intelligence 

Publisher online help. 

4) In the Security Model section, do the following to configure the type of security to use. 

a. From the Security Model list, choose the model to use. This can be: 

 BI Publisher Security 

 Oracle BI Server 

 Oracle Database 

b. Enter the Connection String. This is the connection string used to connect to the JDBC Data 

Source you previously configured. See Launching the Configuration Utility (see "Configuring 

the JDBC Connection" on page 55). 
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Setting Up LDAP with BI Publisher 

Use the information in this section to setup BI Publisher with LDAP. It is assumed that you are already 

familiar with BI Publisher. For more information about BI Publisher, see the documentation that came with 

the product. 

In This Chapter 

Prerequisites for Setting Up LDAP with BI Publisher ...................................................................... 57 

BI Publisher LDAP Setup ......................................................................................................................... 57 

BI Publisher Database Authentication Setup ...................................................................................... 58 

 
 

Prerequisites for Setting Up LDAP with BI Publisher 

Before you begin, ensure that: 

 P6 EPPM is set up with LDAP. 

 Each user who needs access to reports must have Enterprise Reports module access set in the P6 EPPM 
database for the username.  

 The RunETL process has been run.  
 

BI Publisher LDAP Setup 

To set up BI Publisher for LDAP, ensure that all prerequisites have been met (see Prerequisites for Setting 

Up LDAP with BI Publisher (on page 57)), and then do the following: 

1) Create following groups in the LDAP store, and assign the P6 users to that group. 

P6REPORTS – * Contols access to the P6Reports folder 

XMLP_ADMIN 

XMLP_ANALYZER_EXCEL 

XMLP_ANALYZER_ONLINE 

XMLP_DEVELOPER 

XMLP_SCHEDULER 

XMLP_TEMPLATE_DESIGNER 

*All the XMLP groups are specific to BI Publisher security.  For more information, see the BI 

Publisher documentation. 

2) Login to BI Publisher as admin user (http://<ip address>:<port>/xmlpserver), and do the following: 

a. Access the admin options, and choose Security Configuration.  

b. Specify LDAP security model connection information. 

3) Access BI Publisher Admin, Data Sources, and do the following: 

a. Create a new data source called P6ODS.   

b. Specify connection information, odsuser name/password, and choose the option for Use Proxy 

Authentication. 
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4) Copy the P6REPORTS folder from the P6REPORTS.zip file to the BI Publisher application 

deployment location (for example, %BI_HOME%\xmlp\XMLP\Reports). 

Note: The zip P6REPORTS.zip file also includes a folder named "Samples." This 

folder contains PDF files that show what each of the sample reports would look 

like when run. 

5) Restart the application server. 

6) Login to BI Publisher as same admin user, and access Admin, Roles and Permissions. The Role 

P6REPORTS should be read in from the LDAP server. For that role, select Add Folder, and add the 

P6REPORTS folder. 
 

BI Publisher Database Authentication Setup 

To set up BI Publisher database authentication, ensure that all prerequisites (see "Prerequisites for 

Setting Up LDAP with BI Publisher" on page 57) have been met, and then do the following: 

1) After the RunETL process completes, users who had Enterprise Reporting module access were 

granted the role P6REPORTS. The following additional roles were also created, but not granted: 

XMLP_ADMIN 

XMLP_ANALYZER_EXCEL 

XMLP_ANALYZER_ONLINE 

XMLP_DEVELOPER 

XMLP_SCHEDULER 

XMLP_TEMPLATE_DESIGNER 

These are publisher-specific roles that control privileges in BI Publisher.  They must be granted to 

users in keeping with the organization's security model. For more information, see the BI Publisher 

documentation about roles. 

2) Alter the users passwords in the ODS instance. For security reasons, each database user password 

created is a random string. For each user set a password. For example: 

alter user scott identified by tiger; 

3) Login to BI Publisher as admin user (http://<ip address>:<port>/xmlpserver), and do the following: 

a. Access the admin options, and choose Security Configuration.  

b. Specify oracle database security model connection information. 

4) Access BI Publisher Admin, Data Sources, and do the following: 

a. Create a new data source called P6ODS.   

b. Specify the connection information, the odsuser name/password, and then choose the Use Proxy 

Authentication option. 

5) Copy the P6REPORTS folder to the BI Publisher application deployment location (for example, 

%BI_HOME%\xmlp\XMLP\Reports). 

6) Restart the application server. 

7) Login to BI Publisher as same admin user.  

a. Access Admin, Roles and Permissions. The Role P6REPORTS should be read in from database 

roles.  
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b. For that role, select Add Folder, and add the P6REPORTS folder. 
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This section describes how to install and configure Oracle Business Intelligence (OBI).  It also describes 

where to put the Primavera P6 Analytics files for use with OBI. 

In This Chapter 

Overview of Installing and Configuring OBI ....................................................................................... 61 

Installing OBI .............................................................................................................................................. 62 

Configuring OBI to Use RPD ................................................................................................................. 62 

Updating the OraclePrimaveraP6Analytics.rpd for P6 ..................................................................... 63 

Configuring OBI with the Catalog ......................................................................................................... 63 

 
 

Overview of Installing and Configuring OBI 

Oracle Business Intelligence (OBI) is a comprehensive suite of Business Intelligence foundation and 

applications designed to enable the insight-driven enterprise. It integrates data from multiple enterprise 

sources, and transforms it into key insights that enable strategic decision-making, drive continual business 

process improvements, and promote alignment across the enterprise. 

The Oracle Business Intelligence infrastructure consists of servers, programs, and tools used to build 

Oracle Business Intelligence applications. The Oracle Business Intelligence product includes an installer 

program that can install the complete OBI suite, or one or more OBI product components.  

The following are the default Dashboards supplied with P6 Reporting Database: 

 Main 

 Portfolio Analysis 

 Project Earned Value 

 Project Health 

 Resource 

For information about the Business Intelligence & Data Warehousing Technology Center, go to the 

following web site: 

http://www.oracle.com/technology/tech/bi/index.html 

For information about the Business Intelligence & Data Warehousing documentation, go to the following 

web site: 

http://www.oracle.com/technology/documentation/bi_ee.html 

For information about configuring an Impersonator User to be used with Single Sign-On for OBI, go to the 

following web site: 

http://download.oracle.com/docs/cd/E12096_01/books/AnyDeploy/ 

AnyDeploySSO5.html 

Installing and Configuring OBI 
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Note: The preceding URL should all be on one line. Format restrictions of this 

document might prevent it from doing so. 

 

Installing OBI 

For information on installing the Oracle Business Intelligence, go to the following web site: 

http://www.oracle.com/appserver/business-intelligence/index.html 
 

Configuring OBI to Use RPD 

Install Oracle Business Intelligence, and then do the following: 

1) Stop OBI Services (if running). 

2) Add the stardw TNSNAMES.ORA entry that references your Star. This is in the form: 

stardw.world=(DESCRIPTION =(ADDRESS_LIST =(ADDRESS = (PROTOCOL = TCP)(HOST 

=##.###.###.##)(PORT=####))) 

(CONNECT_DATA =(SID=@@@))) 

 

In the preceding entry: 

 The entry must start with stardw.world. 

 For HOST=##.###.###.##, enter the IP address for the Star database in place of 

##.###.###.##. 

 For PORT=####, enter the port number where the Star database resides in place of ####. 

 For SID=@@@, enter the SID for the Star database instance in place of @@@. 

3) If the Star schema username is the same as the default username (STARUSER), copy the P6 Analytics 

repository .rpd to the local repository by copying the following, and then go to step 5. Otherwise, 

proceed to step 4:  

\OraclePrimaveraP6Analytics.rpd 

To:  

\OracleBI\server\Repository\OraclePrimaveraP6Analytics.rpd 

4) If the Star schema username is different than the default username (STARUSER), do the following: 

5) Open the OraclePrimaveraP6Analytics.rpd file using the Oracle BI Administration Tool. 

Note: The default password for the OraclePrimaveraP6Analytics.rpd is 

PMADMIN. 

a. Access Manage, Variables. 

b. Under the 'Repository' Node, select 'Variables'.  

c. Locate the variable DW_USERNAME.  Double click this variable and proceed with the checkout. 

d. When the edit dialog opens, modify the Default_Initializer with the correct STAR user (for 

example, STARUSER_1). 

e. Right click the Physical connection source, and go to Properties\ Connection Pools\. 

f. Click Oracle Primavera P6 Data Warehouse Connection Pool, and go to Edit. 
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g. On the General tab, change the password to be the password of the Staruser. 

h. Click Ok, check in these changes, and save the OraclePrimaveraP6Analytics.rpd file. 

6) Start OBI Services. 

7) Launch the following file:  

\OracleBI\index_bi_ee.html. 
 

Updating the OraclePrimaveraP6Analytics.rpd for P6 

If you are using P6, and want to launch it from P6 Reporting Database, you must update the following file 

with the correct URL and context root for P6 Reporting Database: 

      OraclePrimaveraP6Analytics.rpd  

The following steps are only necessary in that case. 

1) Open OraclePrimaveraP6Analytics.rpd with the BI Administrator Tool. 

Note: The default password for the OraclePrimaveraP6Analytics.rpd is 

PMADMIN. 

2) Access manage, variables. 

3) Under the Repository Node, select Variables. 

4) Locate the variable DW_P6_LINK_BASE_URL, double click that variable, and proceed with the 

checkout. 

5) When the edit dialog opens, modify the Default_Initializer with the correct P6 Reporting Database URL 

(for example, http://p6webaccess:7001/primaveraweb). 
 

Configuring OBI with the Catalog 

Do the following to configure OBI with the Catalog:  

1) Stop all OBIEE Services (OC4j, Oracle AS, Oracle BI Presentation Server, Oracle BI Java Host, and 

Oracle BI Server). 

2) Open the instanceconfig.xml located in \OracleBIData\web\config\ 

a. Find the <CatalogPath> setting. 

For example: <CatalogPath>C:/OracleBIData/web/catalog/P6Analytics</CatalogPath>. 

b. Copy the Catalog to this location. 

c. Under the <CatalogPath> setting, add the following attributes: 

<DefaultStyle>oraclep6</DefaultStyle> 

<DefaultSkin>oraclep6</DefaultSkin> 

<DashboardMaxBeforeMenu>1</DashboardMaxBeforeMenu> 

3) Copy the sk_oraclep6 and the s_oraclep6 folders to the following 2 locations: 

\OracleBI\oc4j_bi\j2ee\home\applications\analytics\analytics\res 

\OracleBI\web\app\res 

4) Restart OBIEE services in the following order: 
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 Oracle BI Presentation Server 

 Oracle BI Java Host 

 Oracle BI Server 

 OC4J 
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This section describes how to install and configure multiple Financial Periods. 

In This Chapter 

Installing Financial Periods ....................................................................................................................... 65 

Configuring the OBI RPD File for Financial Periods ......................................................................... 65 

 
 

Installing Financial Periods 

P6 Reporting Database can use two additional financial periods. Use the following procedure to add the 

additional Financial Periods to your P6 Reporting Database: 

1) You must have previously run the full ETL process. 

2) Connect to your STAR database instance with the STARUSER account. 

3) Run a  query to set the values for fin_period_2 and fin_period_3. For example: 

update w_day_d set fin_period_2 = CHR(64 + cal_month)||'-'||cal_year; 

update w_day_d set fin_period_3 = CHR(64 + cal_month)||'-'||cal_year; 

The preceding queries should each appear on one line. Format restrictions of this document might 

prevent them from doing so. 

4) Commit the changes made in step 3. 

5) Run the Incremental ETL process. 
 

Configuring the OBI RPD File for Financial Periods 

Once you complete the above steps, you will need to configure your OBI RPD file to include the newly 

added Financial Periods. Use the following procedure to configure your OBI RPD file: 

1) Open your OraclePrimaveraP6Analytics.rpd in the Oracle BI Administration Tool. 

Note: The default password for the OraclePrimaveraP6Analytics.rpd is 

PMADMIN. 

2) In the far right section (Physical), navigate to the W_DAY_D table. 

3) Highlight the FIN_PERIOD_2 and FIN_PERIOD_3 fields, drag them into the middle section 

(Business Model and Mapping), and release them in the Dim – Date dimension. 

4) After FIN_PERIOD_2 and FIN_PERIOD_3 appear in the Business Model and Mapping section under 

the Dim – Date dimension, you can drag them to the left section (Presentation) where you want them 

to appear in OBI. You can also rename them there, so they display as you require. 

5) Save the OraclePrimaveraP6Analytics.rpd file. 
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This section describes how to run the Configuration Utility to reconfigure Settings, Options, and Codes 

after P6 Reporting Database is already installed and configured. 

In This Chapter 

Overview of the Configuration Utility ................................................................................................. 67 

Launching the Configuration Utility ...................................................................................................... 68 

Changing Passwords ................................................................................................................................. 68 

Changing Settings ...................................................................................................................................... 68 

Resetting Options ..................................................................................................................................... 69 

Choosing Activity, Project, or Resource Codes ............................................................................... 69 

 
 

Overview of the Configuration Utility 

This section describes where to find the information you need in order to change the following settings and 

options: 

 Java Runtime Environment location 

 Bulk file Load location 

 Logging detail level 

 Start and End dates 

 Project Trend Interval 

 Fiscal Year Start 

After you install and configure P6 Reporting Database, you might need to do the following: 

 Change Java Runtime Environment, Bulk File Load, or Logging settings. See Resetting Options (on page 

69). 

 Change the Date Range, Project Trend, or Fiscal Year Start options. If you purchased P6 Analytics, see 
Changing Settings (on page 68). 

 If you purchased P6 Analytics, you might need to change the Project Trend Interval or Fiscal Year Start 

date. See "Configuring the Project Trend Interval and Fiscal Year Start" in the P6 Analytics Administrator's 

Guide.  

 Delete, or choose additional, Activity, Project or Resource codes. If you purchased P6 Analytics, see 
Choosing Activity, Project, or Resource Codes (on page 69). 

These can be changed by running config.cmd (or config.sh in a non-Windows environment). When you 

run the utility, you will only be able to make changes to fields on the following tabs: 

 Settings 

 Options 

 Codes 

Running the Configuration Utility 
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Fields on the PMDB, Stage, ODS, Star, and Links tabs will not be available for change. 
 

Launching the Configuration Utility 

 The configuration utility should be access-control protected, and should be under administrative 

control.  

To launch the configuration utility, do the following: 

1) Locate the folder where P6 Reporting Database is installed. 

2) Run the config.cmd command (or config.sh in a non-Windows environment). You will be prompted 

to enter the proper security authorization in order to access any data from the utility. After 

authorization completes, you should see the Settings tab on the configuration utility. 

 If it is necessary to do a complete refresh of all data, run the configuration utility from the command 

line in the following format: config.cmd FULL. 

 If you make changes to connections settings when running the configuration utility in FULL mode, it 

might require a Full ETL run. 

3) If the Settings tab is not the one you want, click the appropriate tab (Options or Codes). 
 

Changing Passwords 

If you need to change the passwords for stageuser, odsuser, or staruser you must run the configuration 

utility in FULL mode (see Launching the Configuration Utility (on page 68) for information on launching 

this utility). 

You cannot change passwords by running config.cmd because all connection information fields cannot be 

edited in config.cmd. See Installation Procedure (on page 25) for information on running setup.exe. 
 

Changing Settings 

After launching the configuration utility, you should see the Settings tab. Use the fields on this tab to reset 

the following: 

 Java Runtime Environment location 

 Bulk File Load location 

 Logging detail level 

For information on using the Settings tab, see Configuring Java Virtual Machine, Bulk File Load, and 

Logging Settings (on page 30). 

After you finish changing options, you can do the following: 

 Click the Options tab if you want to make changes for the Date Range. If you purchased P6 Analytics, 

use this tab to make changes to the Project Trend Interval or Fiscal Year Start fields.  

 If you purchased P6 Analytics, click the Codes tab if you want to change, or choose additional, global 
Activity codes, or Project or Resource codes. 

 Click Finish if you are finished making changes. 
 



 Running the Configuration Utility 

 

  69 

 

Resetting Options 

You can use the fields on the Options tab to reset the following: 

 Start and End Dates 

 Project Trend Interval 

 Fiscal Year Start 

For information on using the Options tab, see Configuring the Date Range Option (on page 31). 

After you finish changing options, do the following: 

 Click the Settings tab if you want to changes the Java Virtual Machine or the Bulk File Load location, 
or change the Logging detail level. 

 If you purchased P6 Analytics, click the Codes tab if you want to make changes for the global Activity 
codes, or for the Resource or Project codes. 

 Click Finish if you are finished making changes. 
 

Choosing Activity, Project, or Resource Codes 

You can use the fields on the Codes tab to delete, or choose additional, global Activity codes, or Project or 

Resource codes. 

For information on using the Codes tab, see Configure Activity, Project, and Resource Codes (see 

"Configuring Activity, Project, and Resource Codes" on page 33). 

After you finish changing Activity, Project, or Resource codes, you can do the following: 

 Click the Settings tab if you want to changes the Java Virtual Machine or the Bulk File Load location, 
or change the Logging detail level. 

 Click the Options tab if you want to make changes for the Date Range, Project Trend Interval, or 

Fiscal Year Start fields. 

 Click Finish if you are finished making changes. 
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 This section describes how to configure the Secure Sockets Layer (SSL). SSL ensures a secure 

connection between servers over the network. 

In This Chapter 

Configuring the SSL Connection ........................................................................................................... 71 

Configuring P6 Reporting Database to Use SSL to Run the ETL Process................................... 72 

 
 

Configuring the SSL Connection 

This topic directs you to an Oracle web site that will provide an example of creating a self-signed Oracle 

wallet for the server and client, configuring the database to use TCPS with the server key, configuring an sql 

client to connect through the TCPS protocol, and creating simple java clients that show how to connect 

through TCPS in several different examples. Use these examples to guide you in creating your SSL 

connection.  

Oracle assumes that you already understand the concept of wallets, and that you understand Secure Socket 

Layer (SSL) functionality. 

1) Go to the following web site:  

https://support.oracle.com/CSP/ui/flash.html 

2) On the My Oracle Support window, do one of the following: 

 If you are already have a Username and Password for Oracle Support, click Sign In.  

 If you are a new user, click the New user? Register here link, and follow the instructions to 

obtain a Username and Password. 

3) Enter your Username and Password, and click Go. 

4) On the My Oracle Support Dashboard, in the Search Knowledge Base field, enter 762286.1, and 

press the Enter key (or, click the Search Knowledge Base icon to the right of the field after you enter 

the number).  

5) On the Knowledge Browser Dashboard, select End to End Examples of using SSL with oracle’s 

JDBC THIN Driver to see detailed examples. Use these examples as guides to help you configure 

your system. 

6) Next, configure P6 Reporting Database to run the ETL process using SSL. 
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Configuring P6 Reporting Database to Use SSL to Run the ETL Process 

 Currently, the P6 Reporting Database Configuration Utility does not allow the erdb.properties file to 

be directly configured for TCPS. After it is initially configured for TCP, and after the SSL connection is 

configured, you must manually configure the P6 Reporting Database so that SSL is used to run the ETL 

process.  

1) Using the wallet manager or OraclePKI, export the trusted certificate that is on the server, and copy it 

to client where P6 Reporting Database is installed.  

2) On the client machine, import the certificate using the keytool. For example: 

C:\Program Files\Java\jre1.6.0_20\bin>keytool -importcert -file C:\wallets\server_wallet\cert -keystore 

"C:\Program Files\Java\jre1.6.0_20\lib\security\cacerts" 

Note: The default password for the Java default keystore file 

JAVA_HOME/lib/security/cacerts is 'changeit'. 

3) Edit the erdb.properties file as follows: 

a. Replace all occurrences of the default port number with the number of the SSL port.  

b. Replace all occurrences of PROTOCOL = TCP with PROTOCOL = TCPS.  

4) Run the runSubstitution.cmd file to update all files with the new port number and TCPS setting. The 

file is located in the ERDB_HOME\etl\common\ directory.  
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This section describes how to use Stage database utility tables to track the ETL process. It describes the log 

files that can provide information about the installation and daily operation of P6 Reporting Database. 

In case a problem occurs, it tells where to get help if the log files do not provide sufficient information. 

In This Chapter 

Stage Database Utility Tables ................................................................................................................. 73 

Log Files ....................................................................................................................................................... 76 

Troubleshooting ........................................................................................................................................ 77 

 
 

Stage Database Utility Tables 

During the ETL process, there are several tables that are generated in the Stage database that can be useful 

in tracking the progress of the current ETL. Because these tables always accumulate rows, they can also be 

useful in providing historical information about previous ETL runs.  These tables reside in the Stage 

database only. 

ETL_ProcessMaster Table 

This table (shown in the following example) provides the history of ETL process runs. The start date and 

end date are shown, as well as the type of process.  

 ProcessType=FULL indicates the Full ETL process 

 ProcessType=INCR indicates the Incremental ETL process. 

Process ID ProcessStartDate ProcessEndDate ProcessType 

12345 2010-09-15 14:45:39.683 2010-09-15 16:11:10 FULL 

12346 2010-09-17 09:46:37.183 2010-09-17 10:05:34 INCR 

ETL_ProcessInfo Table 

This table (shown in the following example) provides the details of a particular ETL process run. For each 

step in the ETL process, an entry is logged to this table with an informational message. The ProcessId field 

in this table can be joined to the ProcessId in the ETL_ProcessMaster table. 

The Rows column shows the number of rows that were processed. 

Utility Tables, Log Files, and Troubleshooting 
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ProcessID InfoDate ProcessName InfoMsg InfoType TableName Rows 

4539 2010-09-15 

15:51 

ETLCalc Full, API) 

DAO 

Completed 

without 

errors in 

0.125 

seconds. 

PROGRESS RISK 21 

4540 2010-09-15 

15:51 

ETLCalc Full, API) 

DAO 

Completed 

without 

errors in 

0.406 

seconds. 

PROGRESS EPS 10 

4541 2010-09-15 

15:51 

ETLCalc (Full, API) 

DAO 

Completed 

without 

errors in 

5.5 

seconds. 

PROGRESS WBS 96 

4542 2010-09-15 

15:51 

ETLCalc Full, API) 

DAO 

Completed 

without 

errors in 

0.109 

seconds. 

PROGRESS RESOURCES 41 

4543 2010-09-15 

15:51 

ETLCalc Full, API) 

DAO 

Completed 

without 

errors in 

0.094 

seconds. 

PROGRESS RESOURCE 

CURVE 

12 

The logs capture changes that have been made between Incremental runs. For Example, when a new activity 

code is created, the logging system populates the InfoMsg column, within the ETL_ProcessInfo Table, with 

a new entry that resembles the following:  

actv_code_id=>3500, Operation=>Insert,SKEY=>895 
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ETL_ProcessException Table 

This table shows exceptions (error) conditions that occurred during the ETL process. For each ETL run, 

any exceptions that occur will be logged into this table. The ProcessId field can be joined with the ProcessId 

of the ETL_ProcessMaster. The fields available in the ETL_ProcessException are: 

Field Description 

ProcessId The ID identifying the process. 

ExceptionDate The timestamp of when the exception occurred. 

ProcessName The name of the process that failed. 

ExceptionDescription The text description of exactly what failed within the 

process. 

ExceptionLevel The level of the exception. 

PMDBTableName The name of the P6 EPPM table (if applicable) that was being 

processed. 

ODSTableName The name of the ODS table (if applicable), that was being 

processed 

PKEY The Primary key (if applicable) to the row being processed. 

ProjectId If the error occurred in the context of processing project 

rows, this will be Project Object Id of the project. 

etl_projectChanges 

This table holds project IDs for all projects that have changed since the last update. These projects will be 

updated in the P6 Reporting Database during the next ETL process run. 

etl_parameter 

This table stores settings used by the ETL process. The content of the erdb.properties file is also written 

into this table during a Full or Incremental run of the ETL process. 

W_OBI_EVENT_S table 

Note: This section applies only to P6 Analytics. 

In the NQSCONFIG.ini file, if [CACHE] ENABLE = YES, and an Answers request is created, the values are 

cached. If the values in the Answer request are changed in the P6 EPPM database, the old values can remain 

in the Answers request. The Answers request will not reflect the changes made in the P6 EPPM database. 

This is because the cache is still using the old values for the request. 

The W_OBI_EVENT_S table tracks updates, and enables a cache clearing interval to be set. By default, an 

interval of 20 minutes is set. The W_OBI_EVENT_S table will clear the cache for data recently updated 

during an Incremental run. The setting can be changed in the OBI administration by doing the following: 
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1) Log into the RPD, and go to Tools, Utilities, Oracle BI Event Tables, Execute. 

2) Under Event Tables, select W_OBI_EVENT_S. You can then set the frequency for clearing the 

cache. 

The queries being executed by this event can be viewed in the  NQQuery.log file in the <OBI Installation 

directory>\server\log. This is where you can see the frequency being enforced. 

 Always ensure that log files are secured by preventing unauthorized access. This can be done by using 

file system security. 
 

Log Files 

P6 Reporting Database creates extensive log files for each step of the ETL process (Extract, Transform, and 

Load). In addition, log files are created for each run of the Incremental process.The log files are stored in a 

„log‟ folder in the root of the P6 Reporting Database installation location. 

The log files contain detailed information that you should inspect after running each file in the installation 

process, and after running the Incremental process. 

Log files 

The following lists the log files, identifies when they are created, and gives a brief description of their 

contents: 

File Description 

ETLInit.log Created when runetl.bat (or Runetl.sh) or Incremental.bat 

(or incremental.sh) are run. Contains results of the DAO 

initialization at the beginning of the ETL Process. 

ETLprocess.html Created when runetl.bat (or Runetl.sh) is run. Contains 

results of the processes run to create the users, tables, and 

transfer of data. Derived from the ETL_Master, 

ETL_ProcessInfo, and ETL_Exception tables. 

ETLprocess.log Created when runetl.bat (or Runetl.sh) is run. Contains 

results of the processes run to create the users, tables, and 

transfer of data. There can be additional etlprocess.log-1 if 

runetl has been run multiple times without deleting original 

logs. New logs will be created, and old logs will be renamed. 

Incremental.html Created when Incremental.bat (or Incremental.sh) is run. 

Contains the details of the SQL commands run to perform 

the incremental updates. Derived from the ETL_Master, 

ETL_ProcessInfo, and ETL_Exception tables. 

Incremental.log Created when incremental.bat (or incremental.sh) is run. 

Contains the details of the SQL commands run to perform 

the incremental updates. 
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Troubleshooting 

P6 Reporting Database writes detailed process information to the “log” directory under the P6 Reporting 

Database home folder. The log directory contain information about the installation, as well as about each 

run of the ETL (extract, transform, and load) process. If an error occurs, depending on the nature of the 

error, diagnostic information might be included within the files of the log directory. Analyzing these files, 

can help lead you to the resolution or to the file or process which caused the error. 

Known issue with Oracle 10g - Row Counts in Incremental Log are Zero 

If you are using Oracle 10g, there is an issue with row counts that are used in the ETL process. Because of 

this issue, some of the counts in the Incremental log will appear to be zero, when in fact there are actually 

values. The dbms output that shows rows returned will always be zero when the bug is encountered. 

In the Incremental log, at the point when data is extracted, it shows how many rows were inserted or 

deleted. These will be zero, even if changes were made to the P6 EPPM. New rows will be added during 

Incremental process, but will not show any rows inserted or deleted. 

This will not affect the integrity of the data in the data warehouse. This will only effect the logging. This issue 

has been fixed in Oracle 11g, and there is a patch available for Oracle 10g.  

To see if there is a one off backport fix for your operating system, see Patch 4078618, Bug 4078618: 

SQL%ROWCOUNT% RETURNS ZERO WHEN THE TABLE IS IOT. 

Oracle Database Gateway 11.2 Reporting Incorrect Column Size 

If the Oracle Database Gateway 11.2 reports incorrect column size, and the extract fails, ensure that the 

following are set in the initdg4msql.ora file: 

 HS_NLS_LENGTH_SEMANTICS=CHAR 

 HS_FDS_CHARACTER_SEMANTICS = TRUE 

 HS_KEEP_REMOTE_COLUMN_SIZE=ALL 

The Extract Process Hangs, and CPU Usage is 100% on the Server Running the Database Gateway 

If the Extract process hangs, and CPU usage is 100% on the server running the Oracle database gateway, 

change the threads setting of the extract.bat (or extract.sh on a non-Windows system) so that only one 

dg4msql process will run at a time: 

1) Open the script extract.bat (or extract.sh for a non-Windows system) and look for:  

Step 4. 

%JAVA_INVOKER_PREFIX% %STAGE_CONN% /ACTION:SQLSET rootdir="C:\Documents and 

Settings\<user ID>\rdb\scripts" "STAGEUSER" "PRMCDC" "PRIVUSER" 

priority=priority/stagetables.txt /STEP:4 /STEP_CNT:9 /PART_CNT:1 /UPDATESTATUS:Y 

/NAME:"ExtractPmdbToStage" /PROCESS:"extract" /PART:1 /DESC:"Extract PMDB data into Stage" 

dir="stage_load_full" threads=10 

Notes:  

The preceding command, beginning with %JAVA, and ending with threads=10, should all be on 

one line. Format restrictions of this document prevent it from doing so. 

<user ID> in the command will not be the same on all systems.  

2) Change the threads=10 parameter to be threads=1. 
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3) Save and close the file. 

The configuration utility does not launch during the P6 Reporting Database installation process 

If you are installing P6 Reporting Database and the Configuration utility never launches, the most likely 

cause is that the location used for JRE is incorrect. To correct this issue, run the setup.exe or runInstaller 

process again, and ensure that you specify the correct location for your systems Java Runtime Environment 

(JRE). 

Rebuild P6 Reporting Database procedures 

It may sometimes be necessary to rebuild and recreate all of the scripts that are required to run the Full or 

Incremental ETL process. If you need to do this, do the following: 

1) Go to the <installation folder>\p6rdb\scripts folder.  

2) Run one of the following files: 

 Rebuildprocs.bat (in a Windows environment)  

 Rebuildprocs.sh (in a non-Windows environment)  

Manually Increase Acceptable Error Size 

When running the runetl process, errors may be produced due to bad data or other related issues which 

should not cause the process to fail. This error level by default is set to 512. For larger data sets this error 

level can be increased to allow the process to complete and the problematic data can be reviewed at a later 

time.  

Edit the transform.bat or transform.sh file and alter the SET JAVA_INVOKER_PREFIX by adding 

-Dprimavera.max.record.errors=1024 to it. For example: 

SET JAVA_INVOKER_PREFIX="/home/pbk/local/jvm/jre1.6.0_20\bin\java" -Xmx1024m 

-XX:+UseParallelGC -XX:+UseParallelOldGC -XX:GCTimeRatio=19 -Dprimavera.batch.size=10 

-Dprimavera.spread.batch.size=8 -Dprimavera.progress.counter.fraction=4 

-Dprimavera.max.record.errors=1024 -Djava.ext.dirs=..\lib;"/home/pbk/local/jvm/jre1.6.0_20"\lib\ext 

-Dprimavera.bootstrap.home="/home/pbk/rdb/indy" -Djava.awt.headless=true -classpath ..\res 

com.primavera.er.util.CommandInvoker -classpath ..\res com.primavera.er.util.CommandInvoker 

Contacting Customer Support 

For detailed information about contacting Customer Support, see Where to Get Support (on page 10). 

If you have a question about using P6 Reporting Database that you or your network administrator cannot 

resolve with information in the documentation, please contact Customer Support.  
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This section describes how to uninstall the P6 Reporting Database for Windows and non-Windows 

systems. For information on supported Windows and non-Windows platforms, see the Tested 

Configurations document on the release media or download. 

In This Chapter 
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Uninstalling the Software 

To uninstall P6 Reporting Database, perform the following steps. 

Note: Due to the global nature of the Oracle Universal Installer (OUI), the OUI 

online help is not applicable for installing or uninstalling P6 Reporting 

Database or for references to the  documentation. Instead, refer to the 

following for uninstalling instructions. 

1) From the P6 Reporting Database physical media or download location, run one of the following 

depending on your system type: 

If you are uninstalling on a Microsoft Windows system, 

windows\Disk1\install\setup.exe 

 If you are uninstalling on a non-Microsoft Windows system, 

<Operating System>\Disk1\install\runInstaller 

Where: <Operating System> is a supported non-Windows platform. For information on supported 

platforms, see the Tested Configurations document on the release media or download. 

2) Click Deinstall Products. 

3) Select the name that represents the P6 Reporting Database installation and click Remove. 

You determined the name that represents the P6 Reporting Database installation when you installed 

the product. 

4) If the name of the item to remove is correct, click Yes to confirm. 

5) Click Close. 

6) Click Cancel and then Yes to confirm. 

7) If you are uninstalling on a Microsoft Windows system, delete the <installation folder>p6rdb folder, 

where:  

<installation folder> is the folder in which you installed P6 Reporting Database. 
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